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Chapter 1:  Introduction 

1.1 What is MobileFlex? 

MobileFlex enables Microsoft™ Retail Management Software users to extend their RMS systems 
to the point of activity.  With MobileFlex, end users can eliminate errors and streamline processes 
that benefit from barcode enabled data collection including inventory, shipping and receiving, sale 
mark downs and shelf re-labeling.  MobileFlex is simple to install and connects seamlessly to 
your RMS data via batch or wireless technology.   
 
Highlighted Features: 
 

• Seamless data sharing to mobile terminals via wireless or batch technology. 
• Customizable label printing supports most mobile and desktop barcode printers. 
• Tight integration with RMS allows data to flow directly between handheld and RMS 

databases. 
• Easy to configure to meet specialized needs. 

 
1.2 Free Trial 

MobileFlex is a shareware application.  Shareware applications allow end users to trial full feature 
sets of software applications for no fee.  We encourage anyone trialing MobileFlex to contact us 
with any questions that arise during the trial process so we can insure you are completely 
satisfied with the product after purchase.   
 
The trial download is limited in that only 5 records will transfer to and from each handheld session 
to RMS.  After you purchase MobileFlex, simply fill out the MobileFlex Registration Request Page 
accessible from your PC’s Start Menu.  A registration code will be sent within 24 hours.  
Alternatively, you can register from our website at http://www.mobileflex-pos.com .  This 
registration code will activate your trial version, enabling it for full use.  There is no need to 
reinstall. 
 
1.3 Learning MobileFlex 

To discover the full power of MobileFlex, we strongly recommend that you read this manual 
thoroughly.  We also encourage users to take advantage of training classes offered by most 
MobileFlex dealers. 
 
1.4 MobileFlex Batch or Wireless Mode 

MobileFlex can share data with RMS in either a batch or wireless mode depending on the 
barcode terminal capabilities and the availability of a wireless network.  
 
Batch mode allows users without a wireless network to sync RMS data directly to their PDA for 
inventory audits, label printing and other RMS operations.  After the user has completed the 
necessary tasks, data is simply synchronized back to the RMS database. 
 
Wireless Mode enables end users to view and share data in a real time environment with RMS.  
This does require a wireless network to be in place.   
 
 
1.5 Compatible PDAs and Bar Code Terminals 

MobileFlex is designed to extend the reach of your RMS data with or without a bar code enabled 
PDA.  However, to discover the full power of MobileFlex, we recommend using a barcode 
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enabled PDA.  A partial list of the current barcode enabled PDAs supported by MobileFlex are 
listed below.  Most of these units are available for purchase at http://www.mobileflex-pos.com. 
Also available through MobileFlex resellers. 
 
 
Currently Supported Windows Mobile 2003, 5.0, Pocket PC, Windows CE, and CE.Net 
Bar Code and PDAs Terminals include: 
 
Symbol PPT2700 Series  
Symbol PPT2800 Series 
Symbol PPT8800 Series 
Symbol PDT8100 Series 
Symbol MC50 Series 
Symbol MC70 Series 
Symbol MC3000 Series 
Symbol MC9000 Series 
Intermec 
Most Unitech devices 
Most Opticon devices 
Most Data Logic devices 
Most HandHeld Products devices 
PSC 
 
MobileFlex with Socket Plug-in scanner is compatible with the following devices: 
 
IPAQ 
Dell Axim 
Most Casio Handhelds 
Most Windows Mobile cell phones and PDAs 

 
 

1.6 MobileFlex Support 

As a registered MobileFlex user, you receive free e-mail support for 30 days from the date of 
purchase.  During this period, we are available to answer any MobileFlex questions.  Our goal is 
to provide MobileFlex users the tools to capitalize on the efficiencies of mobile and bar code 
technology.  Please visit http://www.mobileflex-pos.com to learn more.  To contact Technical 
Support, please e-mail support@ptshome.com.  
 
Extended support agreements, including phone support, can be purchased through your 
MobileFlex value added reseller. 
 
An easy to use knowledge base is available to answer the most common MobileFlex questions.  
The knowledge base is located at http://www.mobileflex-pos.com/kb/
 
We also host a MobileFlex User Group.  The group was created to offer our users a 
communication channel in which to discuss MobileFlex.   You can join the MobileFlex User Group 
at http://www.mobileflex-pos.com. 
 
 
1.7 How to Buy MobileFlex 

MobileFlex is available for purchase through RMS Resellers nationwide.  Contact a MobileFlex 
representative directly at 1-877-640-4152 for a list of local resellers or visit the MobileFlex website 
at http://www.mobileflex-pos.com/.  
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MobileFlex Value Added Resellers specialize in RMS systems and integration.  They are certified 
in MobileFlex and RMS enabling them to handle any integration question or concern you may 
have.  MobileFlex resellers also specialize in providing cost effective bar code and wireless 
systems for end users. 

MobileFlex- PPC M-0001.0  6 



Chapter 2: Installation 
 
Chapter 2:  Installation 

This chapter explains the steps for installing MobileFlex in detail.  
 
2.1  System Requirements 

1. Windows 98/NT/2000/XP/Vista 
 
2. ActiveSync version 3.5 or higher 
 
3. A PDA or Bar Code enabled terminal running Windows Mobile, Pocket PC, or CE version 

3.0 or higher. 
 
4. If MobileFlex is going to run in a Wireless environment, a license of Mobile Flex Wireless 

Server is required. 
 

5. A licensed version of Microsoft RMS™ 1.3 or higher. 
 
2.2 Automatic Installation 

1. Download mobileflex_ppc.exe from http://www.mobileflex-pos.com or any authorized 
reseller’s website. 

2. Double click mobileflex_ppc.exe in the folder to which you saved the download. 

3. Follow the standard installation instructions. 

4. The MobileFlex application is now ready for use on your portable device or will be 
available on your next ActiveSync depending on your configuration.  The MobileFlex 
application is located under Start Menu Programs on your PDA.  It is also available from 
your Pocket PC via the shortcuts taskbar after running for the first time. 

2.3 MobileFlex Database Configurations 

After installing MobileFlex to the handheld, the application will now ask you to configure your 
Microsoft ™ RMS Database location. 

  
 1.   Select your RMS Server from the Server drop down menu. 
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 2.   Select the authentication preference; Windows NT or SQL Server.  

 3.   Enter your SQL Server User Name. 

 4.   Enter your SQL Server Password. 

 5.   Click the Next button. 

 

  
  

 6.   Select your RMS Database from the Database drop down menu. 

 7.   Click the Next button. 
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 8.  Click the Install button to begin the installation. 

 
2.4 Installing MobileFlex on Multiple PDAs 

Before installing MobileFlex on multiple PDAs, it is recommended that each PDA be connected at 
least once via ActiveSync and assigned a PDA user name.  With MobileFlex installed on your PC, 
use the Install to PDA shortcut to install the PDA portion of the application to the PDA(s) in your 
installation.  The PDA install tool can be found on your PC.  Click Start → Programs → PTS → 
MobileFlex and select Install to PDA.  Simply perform an ActiveSync and MobileFlex is installed 
on the PDA. 
 

         
 
2.5 Registering MobileFlex 

MobileFlex is an application that requires registration for full functionality.  The trial version of 
MobileFlex limits the number of records transferred to the PC to five (5), and the number of 
sessions to three (3).  Once MobileFlex is registered, these trial limitations are lifted. 
 
We encourage all users who benefit from MobileFlex to register their copy.  To register 
MobileFlex, we only require your MobileFlex PDA ID, order number, plug-ins being used 
(wireless, or print) and an e-mail address.  We generate a unique registration code for each 
MobileFlex PDA ID and the version of MobileFlex you select so it is important that you send the 
ID exactly as it appears on the MobileFlex splash screen - capitalization is critical.  
 
How to Register:  
 

1. On your PC, click on Start  Programs  PTS  MobileFlex, and select Registration 
Info. 

2. Locate the PDA IDs you wish to register, and click on the link to purchase the software. If 
you have already purchased MobileFlex through PTS or an authorized reseller please 
proceed to step 4. 

3. Once your purchase is completed and payment is received, you will receive an order 
confirmation from PTS.  

4. Complete, review and submit the Registration Info form on your PC.   

Note: Make sure that the correct version of MobileFlex is selected.   Also confirm 
that plug-ins and external devices are selected if they are being used. 

5. Once this step is completed, your registration code is e-mailed to the address provided.  
This process usually takes one hour but we ask that you allow one business day in the 
event of heavy traffic or any other delay. 

6. Once you receive your registration code, follow the instructions below to enter the code 
into your PDA.   

  
Entering Your Registration Code 
 

1. Start the MobileFlex application on the PDA. 
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2. Click the Register button in the MobileFlex Splash Screen.  

3. Enter your Registration Code at the Code prompt. 

4. If the Registration Code is valid, you will receive a Thank you for Purchasing 
MobileFlex message. 

 

2.6 Removing MobileFlex Installation 

In the unlikely event that you would like to remove MobileFlex from your PDA, follow these simple 
instructions. 
 

1. Use the Add/Remove Programs feature in MS Windows via control panel to remove 
MobileFlex from your PC. 

 
2. On your PDA, navigate to Start  Settings  System  Remove Programs.  Highlight 

MobileFlex and select Remove.   
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Chapter 3: Data Synchronization 

 
3.1 MobileFlex Synchronization Modes 

Mobile Flex is available in two data synchronization modes: real time over a wireless network or 
batch using a batch synchronization process.  In batch mode, a user must place their PDAs in the 
cradle and perform a synchronization after changes are made. 
 
3.1.1 Wireless 

In wireless mode, the handhelds are viewing and editing RMS™ data in a real time environment 
utilizing a wireless network.  This allows all users connected to MobileFlex to see any changes 
made to the RMS™ data immediately. 
 
To connect MobileFlex to the MobileFlex Wireless Server follow these steps: 
 

1. Open the plug-ins form by navigating to Admin Manage Plugins.  
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2. From the Plugins form, enter the IP address and port of the server and click Done. 
This needs to be performed for each wireless session being used. Wireless sessions 
are preceded by a “WS_” in the session name. 

 

       
 
3. Once connected, all MobileFlex transactions are performed in real time over a 

wireless network. 
 
3.1.2 Batch 

MobileFlex is pre-configured to operate in batch synchronization mode.  Batch synchronization 
requires a cradle to be tethered to a host PC with a licensed copy of RMS™.  When running in 
batch mode, records are initially sent to the PDA for processing.  Once the synchronization is 
complete, the connected PDA now contains all the up to date information entered in the RMS™ 
system.  Synchronization should occur after all tasks are completed on the PDA.  This keeps all 
connected PDAs current with the most recent RMS™ data. 
 
To perform this synchronization, open the RMS™ Store Operations.   
Select Utilities Add-Ins Sync MobileFlex. This synchronizes all of the RMS™ store data with 
MobileFlex running on the handheld device. 
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Chapter 4: Managing Inventory 

MobileFlex features simple to use inventory modules which streamline store inventory operations, 
reduce errors and offer a significant return on investment.  Item descriptions can be viewed and 
modified on the store floor via the Item List module.  Additionally, inventory audits can be 
conducted on the handheld including Physical Inventory and Blind Physical Inventory which 
greatly increases inventory count speeds and reduce errors.  
  
4.1 Syncing a Store Item List (Batch Mode Only) 

Having the store item list on the handheld is very helpful to store personnel.  Item lists are 
traditionally used to quickly visually find store merchandise without access to the barcode.  Using 
the item list, the store personnel can find items, check inventory levels, as well as check pricing 
and sale information. 
 
 
 
 
 
 

Note: All of the inventory sessions can also be performed in a wireless real-time environment. 
To do this, follow the steps in section 3.1.1 to connect to the MobileFlex Wireless Server.  Use 
the Wireless tab on the Launcher to open each of the inventory sessions described below. 

 
To sync and view a Store Item List in MobileFlex, follow these steps. 
 

1. In the RMS Store Manager application on the PC, simply navigate to 
Utilities Synchronize MobileFlex and select Synchronize MobileFlex. 

 
2. The next time a handheld is connected to the cradle the latest Item List is sent to the 

PDA.   
 
3. To access the Item List go to the MobileFlex Launcher. From the Launcher select the 

Inventory Tab. 
 

 
 

6. To view the entire Item Master table, tap the Item List icon. This opens the item list 
where the user may search for items contained in the Store inventory. A screen shot of 
the store list is shown below. 
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     Searching for items: 
 

1. Select the field to search. 
 
2. Enter the value to find. 

 
3. Click on the binoculars button. 

 
4. If an item is found it will open the item in the entry form. 

 
 
4.2 Scan Item 

When store personnel have access to an item’s barcode but need additional information on an 
item such as price, sale price, end of sale date and stock levels. The Scan Item Module is used.  
 

1. To access the Scan Item Form, tap the Scan Item icon. 
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2. The user is brought to the Scan Item Form.  The user may scan item codes into the Item 
Code field or key the value in using the keyboard, if necessary. If the item is found in 
inventory it is displayed within the form. The form will display data such as: Item, 
Description, Location, Price(s) and Quantity. 

 

                   
 
 
4.3 Conducting Inventory Audits 

This chapter describes how to perform physical inventories and blind physical inventories using 
RMS™ in conjunction with MobileFlex.   Standard Physical Inventories are commonly used in 
order to quickly correct inventory discrepancies and allow end users to initiate investigations into 
these errors.  Blind Physical Inventories do not give store personnel visibility into expected stock 
levels and are traditionally used by management to speed the inventory process and at the same 
time allow management to uncover all inventory discrepancies.  
 
4.3.1  Creating Physical Inventory for MobileFlex in RMS 

To conduct a physical inventory using MobileFlex, one must be created and opened using RMS™ 
Store Operations. To do this, follow these steps. 
 

1. Select Inventory Physical Inventory from the File menu. 
 

   
 

1. A list of all currently open physical inventories will appear.  
 
2. To create a new physical inventory click New. 
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4. In the Create Physical Inventory Count screen select a physical inventory type.  
 
Note: Refer to the RMS™ user manual for more information on the different 
options when creating a physical inventory.  
 

5.   For this example we will select Generate for all items in the selected group and 
select All Items from the group selection area. After the selections are made click 
OK. 
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6. A dialog displaying all the items in the selected group will be displayed. Enter a 
reference number and a name for the physical inventory. Finally, click OK to create 
the physical inventory. 

 

  
 

7. The physical inventory list will now contain the newly created physical inventory and 
is available for the PDA.  

 
4.3.2 Syncing Physical Inventory to MobileFlex  

If using MobileFlex in batch mode the new physical inventory information must now be synced 
to the handheld. These steps can be ignored when operating in a wireless environment.  
 

1. Select Utilities Sync MobileFlex from the File menu.   
2. A dialog box will be displayed showing the synchronization progress. 

 

  
 

3. Once the synchronization is complete the newly created physical inventory can be 
completed using the handheld device.  
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4.3.3 Conducting a Standard Physical Inventory 

Standard Physical Inventories allow store personnel to scan items to be counted and check the 
expected quantities. These items can then be scanned one by one or they can be counted and 
entered manually using the PDA’s keyboard. To complete a standard physical inventory follow 
the following steps. 
 
Open MobileFlex on the handheld. The main Launch screen will be displayed. Select the 
Inventory tab, and select the type of physical inventory preferred.  

 

              
 
To begin the inventory: 
 
1. Select the reference number that m

physical inventory. 
 

         
 
2. Begin scanning items. When an item

quantity appears. 
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3. Continue scanning items one by one, or enter the value by tapping in the quantity 
field. When the quantity field is selected a number pad will appear where the user 
can enter the counted quantity manually. 

 
4.3.4 Conducting a Blind Physical Inventory 

The blind inventory does not display item information when a scan is performed. After 
scanning a count is added and this is added to the running total during the physical 
inventory. 
 

 
 
To complete a blind physical inventory: 
 
1. Select the Physical ID reference number from the Inventory Ref# drop down. 
 
2. Scan an item into the Item Code field. 
 
3. Enter the quantity counted in the Count field or simply select Submit to count one 

item. 
 
4.3.5 Syncing Physical Inventory Counts to RMS™ Store Operations 

When operating in batch mode the physical inventory data must now be synchronized. These 
steps can be ignored when operating in a wireless real-time environment. 
 
To do this, simply place the handheld device in the cradle, open RMS™ Store Operations, and 
select Utilities Sync MobileFlex from the File menu. Your counts will now be transferred into the 
RMS™ system. 
 
4.3.6 Completing the Physical Inventory 

When the physical inventory count has been completed using MobileFlex the inventory counts 
must be committed to your store inventory. Select Inventory Physical Inventory from the File 
menu. 
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The physical inventory list will appear. Double click on the physical inventory which was just 
performed. 
 

  
 
The counts will now be displayed which came down from the handheld. At this point the user can 
either edit these values or calculate the discrepancies. To calculate the discrepancies select 
Calculate. 
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The inventory count discrepancies will be displayed and the user may now commit this to the item 
list, by selecting Commit. This will adjust quantities within your store database. 
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Chapter 5: Shipping and Receiving Inventory 

MobileFlex features Shipping and Receiving modules that allows store personnel to receive items 
on purchase orders, receive store transfers and ship items from inventory. Each module quickly 
and easily adjusts store inventory and minimizes errors when shipping and receiving. 
 
5.1 Managing Purchase Orders with MobileFlex 

In order to receive items using MobileFlex, purchase orders must first be created and transferred 
to the handheld device.  This operation is included in the RMS documentation but is documented 
here to further describe the MobileFlex workflow. 
 
 
 
 
 
 
 

Note: All of the shipping and receiving sessions can be performed in a wireless real-time 
environment. To do this, follow the steps in section 3.1.1 to connect to the MobileFlex 
Wireless Server. Then use the Wireless tab on the Launcher to open each of the inventory 
sessions described below. 

 
5.1.1  Creating Purchase Orders 

1.  Open RMS™ Store Manager. Navigate to Inventory Purchase Orders, or use 
the TaskPad.  

 

    
 

4. This opens a dialog displaying all currently open Purchase Order in the RMS™ 
system. 

 
5. To create a new Purchase Order select New on the right side of the form. 
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6. The Purchase Order creation dialog will be displayed.  
 
7. Select the type of purchase order to be created.  

 
Note: For more information on these options refer to the RMS™ user guide for creating 

purchase orders.  
 
7.    In this example, the Create a new blank purchase order for manual entry is 

selected.  This option allows the user to add items to the purchase order as 
needed. 

 

                 
 

8. After creating a blank purchase order, the Purchase Order dialog is displayed.  
 
9. Enter information regarding the PO from this dialog 
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10. Click on the Contents tab to begin adding items to the purchase order. 
 
 

                 
 

11. Inventory items can be added from the contents tab.  
 
12. Click Add to display a list of the store’s inventory and add items as needed. 
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13. In order for this information to be synchronized to MobileFlex, the Purchase 
Order must be marked as Ordered from the Placement status drop down.  

 
                   

 
 
Note: For more information on Purchase Orders please refer to the RMS™ 
user guide. 

 
 
5.1.2 Synchronize Purchase Orders to MobileFlex (Batch Mode Only) 

When the Purchase Order has been completed, MobileFlex should now be synchronized. Select 
Utilities Sync MobileFlex from the RMS™ Store Operations File menu. The Synchronization 
dialog will appear. When the synchronization is complete MobileFlex will contain the new 
Purchase Order information. 
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5.2 View Items on a Purchase Order 

 
Using MobileFlex a user can view all items and their quantities on a purchase order directly on 
the PDA. 
 

1. Select the Ship/Receive tab from the launcher 
 
2. Select the View PO icon. 

 

 
 

3. This will bring up a form showing all open Purchase Orders. 
 

 
 

4. Scan or enter the PO reference number in the Find field. If entered using the 
keyboard select the binoculars button. The grid is now filtered to show all items 
on the PO and the ordered quantity. 
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5. Press the binoculars button again to remove the filter. 
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5.3 Receive Inventory via Purchase Orders 

Open MobileFlex, from the Launcher screen select the Ship/Receive tab. If using the MobileFlex 
Wireless Server, select the Wireless tab and click on Receive Inventory.  
 

1. To receive a Purchase Order click the Receive POs icon. 
 

                    
 

2. From the entry form select the PO you are receiving. 
 

 
 
3. Scan the item being received. 

 
4. If required enter the number of items to being received or click Submit to receive 

one item. 
 
5. When complete click Done. 

 
6. Synchronize MobileFlex using the Sync MobileFlex process described in section 

3.1.2. 
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5.4 Creating Transfer Inventory In Orders 

When transferring items from store to store a Transfer Order is created within RMS™. The 
process for receiving a store transfer is similar to creating a Purchase Order. Open RMS™ Store 
Manager and select Inventory Transfer Inventory In. From here follow the steps in 5.1.1 for 
creating a Transfer Order and adding items. 
 

 
 
5.4.1 View Items on Store to Store Transfers 

 
Using MobileFlex a user can view all items and their quantities on a store to store transfer directly 
on the PDA. 
 

1. Select the Ship/Receive tab from the launcher 
 

2. Select the View Transfer icon. 
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3. This will bring up a form showing all the open Transfers 
 

 
 

4. Scan or enter the Transfer reference number in the Find field. If entered using 
the keyboard select the binoculars button. The grid is now filtered to show all 
items on the transfer and the item’s quantity. 

 

 
 
5. Press the binoculars button again to remove the filter. 
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5.4.2 Receiving Inventory on Transfer In Orders 

 
1. To receive a Transfer Order click the Receive Inventory icon. 

 

                    
 

2. From the entry form select the Transfer In Order you are receiving, either by 
scanning or typing. 

 

 
 
3. Scan the item being received. 

 
4. If required enter the number of items to being received or click Submit to receive 

one item. 
 
5. When complete click Done. 

 
6. Synchronize MobileFlex using the Sync MobileFlex process described in section 

3.1.2. 
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5.5 Shipping Inventory 

MobileFlex also offers the ability to ship items from your inventory. This process will limit mistakes 
when removing items from your store’s inventory and automatically adjust your quantity on hand. 
To ship inventory a Transfer Out Order must be created using RMS™ Store Manager. This 
process is documented in the Store Operation manual however the steps are outlined below to 
show the process when integrated with MobileFlex. 
 
 

1. Open RMS™ Store Manager and select Inventory Transfer Inventory Out. 
This will open the Transfer Inventory Out dialog. 

 

  
 

2. The Transfer Inventory Out dialog will display all currently open Transfer Out 
orders. To create a new Transfer Out Order click New. 

 

 
 
3. The Transfer Out Order creation dialog will now open. From this dialog enter all 

information about this transfer. More information regarding this form can be found 
in the RMS™ manual. 
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4. To add store items you wish to transfer out click on the Contents tab. 
 
5. Click on the Add Item button to add items to the transfer. 
 

 

  
 

6. When complete click OK. 
 
7. Finally, if running MobileFlex in batch mode, perform a synchronization as 

described in section 3.1.2. 
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5.6 Ship Items on the Store out Transfer 

 
1. To ship a Transfer Order click the Inventory Out icon. 

 

                    
 

2. From the entry form select the Inventory Out Order you are shipping, by either 
scanning or typing it in. 

 

 
 
3. Scan the item being shipped. 

 
4. If required enter the number of items to being shipped or click Submit to ship 

one item. 
 
5. When complete click Done. 

 
6. Synchronize MobileFlex using the Sync MobileFlex process described in section 

3.1.2. 
 

7. Open the Transfer Order List in RMS™ Store Manager. 
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8. Select the Transfer Order which was just shipped. 
 

9. Click the Issue button to open the Transfer Out dialog.  
 

 
 

10. Select Commit to adjust your stores quantities to reflect the new changes. 
 
11. The Transfer Out Order is now complete, and your store inventory has been 

adjusted.
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Chapter 6: Sale Labeling and Re-Labeling 

Labeling Sessions 
MobileFlex offers simple to use and extremely flexible labeling sessions. These sessions can be 
used for re-labeling items or marking down items on sale. These labels can be printed directly to 
any portable or stationary printer using a network, Bluetooth, or serial connection. MobileFlex’s 
powerful printing format allows users to customize the print format to fit their needs. Include store 
logo’s, names, or any other information to completely customize the label. 
 
The two labeling sessions included with MobileFlex are a re-labeling session, and a sale labeling 
session. To access these sessions open MobileFlex. From the launch screen select the Label 
tab. 
 

 
 
6.1 Re-Labeling 

To re-label an item click on the Re-Labeling icon, the following form will be displayed. 
 

 
 
Re-Labeling Form 
To re-label an item, scan or key in the item code into the Item Code field. This will bring up the 
item information from the item list. Enter the number of copies to be printed and press the Print 
button. Upon submit, the labels will be printed. 
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6.1.1 Re-Label Log 

 
When using the Re-labeling session in batch mode a log will be created of all the printed labels. 
Occasionally the user may want to delete this log file. 
 

1. Click on the Label tab from the launcher. 
 

  
 
2. Select the Re-Label Log icon. 
 
3. Select Options->Delete All to clear the Re-Label log. 
  

  
 
6.2 Sale Labeling 

To mark down items select the Sale Labeling icon from the launcher screen. This will bring up the 
following form. 
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Sale Labeling Form 
From the sale labeling form scan or key in an Item Code into the Item Code field. This will bring 
up the item information as well as the current sale information. Simply enter the number of copies 
and press Print, to print the sale labels. The user may also edit the sale price from the currently 
set price in the item list. 
 
6.2.1 Sale Label Log 

 
When using the Sale labeling session in batch mode a log will be created of all the printed labels. 
Occasionally the user may want to delete this log file. 
 

1. Click on the Label tab from the launcher. 
 

  
 
2. Select the Sale Label Log icon. 
 
3. Select Options->Delete All to clear the Sale Label log. 
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Chapter 7: MobileFlex Plug-ins 

Plug-ins 
Available Plug-ins for MobileFlex include the Wireless Plug-in for real-time data transfer and the 
Print Plug-in used for printing labels directly from a mobile printer or network printer. 
 
7.1 Wireless Plug-in 

To enable the wireless connectivity an evaluation or registered version of MobileFlex Wireless 
Server must be configured on the host PC and the Wireless Plug-in along with the wireless 
sessions must be used on the handheld.  To enable the Wireless Plug-in, follow the directions 
below: 
 

1. In MobileFlex select Admin Manage Plug-ins. 
 
2. Select the Wireless tab. 

 
3. Check Enabled. 

 
4. Enter the Server host and Port to be used for the connection. 

 

 
 
7.2 Printer Plug-in 

To enable the printer plug-in an evaluation or registered version of MobileFlex Printer plug-in 
must be installed and enabled on the handheld. To configure the Printer plug-in follow the 
instructions below: 
 

1. In MobileFlex select Admin Manage Plug-ins. 
 
2. Select the Printer tab. 

 
3. Check Enabled. 

 
4. Select the printer you want to use from the drop down list. 

 
5. Select the report you want to use from the drop down list. 
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Note: The report is the format you would like to print in. You can select one of the pre-
configured reports that come with MobileFlex, or you can create your own. 

 
6. Select the default print option when you select File Print. This includes All records, 

Current record, or Prompt for filter. 
 

Start Print Automatically 
Select this if you would like MobileFlex to print automatically when you select File Print. 

 
Auto Print on Submit 
This option allows you to print automatically when a record is submitted in the entry screen. 

 
Test Print 
Press this to test your printer settings. 
 
Options 
Use the Options button to configure the connection settings for the selected printer. 

 
 

 
 
 
Print Options Dialog 
To configure the printer select the Options button. The following dialog will be displayed. 
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The Print Options dialog allows you to select how the printer is connected to the handheld. 
Available options are RS232, and TCP/IP.  
 
To configure a cabled connection (RS232): 
 

1. Select RS232 from the Comm Type drop down.  
 
2. Select the appropriate settings for your handheld and connected printer. 

 
 
 
 
 
 
 
 
 
 
 
 
 

   Common ports for Symbol terminals: 
 
Device                                                                         Comm Port 
Symbol MC50………………………………………………………………………………5 
Symbol PPT 88xx………………………………………………………………………….7 
Symbol PDT 81xx………………………………………………………………………….7 
Symbol MC90xx…………………………………………………………………………...1 

Another available option is a TCP/IP connection to the printer. Using a wireless handheld with 
MobileFlex and a networked printer you can print wirelessly using MobileFlex.  
 
To configure a TCP/IP connection: 
 

1. Select TCP/IP from the Comm Type drop down. 
  
2. The following options will then be displayed. 
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3. Enter the Host IP address, and Host Port of the printer.  
 
4. If all settings are correct, MobileFlex will now print to the configured network 

printer. 
 
Print Prompt Dialog 
When File Print is selected the following printer dialog is shown.  
 

 
 
This dialog allows you to select specific records to print. The options include all records, current 
record or use a filter to choose a range. To set a filter: 
 

1. Select the field to filter on from the drop down. 
 
2. Enter filter criteria. 

 
 
7.3 The Launcher Shortcut   
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The Launcher Shortcut is used to return to the main menu of MobileFlex. Press this shortcut at 
anytime time to return to the launcher to select a different MobileFlex session. 
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